Structural Engineering Library
Installation / Activation / Update
Common Support Questions
Installation
Installation of the Structural Engineering Library (SEL) and the Network License Manager (NLM)
is handled by one installation program located at this link :
http://www.enercalc.com/Users/ECSEL6_SETUP
This installation program asks for your Product Control Code so it can determine the most recent
version of the software you are allowed to install. It then downloads the proper installer and
proceeds.
Sometimes the downloaded installer cannot run because of restrictions caused by a Windows
program launching mechanism. In this case you need to contact support@enercalc.com and
request a simplified installer for your license (always provide your “KW” user registration
number).
When do I need to use the “Product Control Code” (PCC) ?
The PCC is used at two different times.
l

The main installation program asks you to paste in the PCC so that the correct version to
install can be determined. This is true when installing both the SEL and NLM.

l

The PCC must be entered into the ENERCALC software so that an Internet Activation can be
performed. For single license users you paste it into the SEL. For network license users it is
pasted into the NLM, not the SEL.

Can I install the SEL on a computer and use a shortcut from another to run it ?
No, the SEL must be fully installed on the computer where the program will be run. The SEL
uses many software components that must be registered with the specific computer (which
cannot be done running the software remotely).
How many computers can I install the SEL on?
You can install the SEL on ANY computer you want to use it on. That is not a violation of
licensing. The “Activation” requirement of our software controls usage of the number of licenses
you own.
How can I move my software to a different computer?
This is a simple task :
1 - Uninstall the software from your current computer
2 - Locate any ENERCALC data files with the extension “Ec6” and back them up to
a portable memory device
3 - Locate your Product Control Code. Use the most recent one that we send you.
4 - Download the installation program : http://www.enercalc.com/Users/ECSEL6_SETUP
5 - Run the installation program on your new computer (pasting your PCC in the process)
6 - Start the installed software and use “Internet Activate”
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How do I install the software so all my engineers can use it?
You have two options, but you will always need to install the software on any computers you wish to use.
l
l

If you DO NOT have a network license then you will "activate" the individual licenses and can
deactivate/activate to use other computers.
If you have a network license (min. two seats) the software comes with a Network License Manager
which allows any local TCP/IP connected computer to run the software. When you launch the software
it will use "subnet broadcasting", locate the Network License Manager and acquire permission to run.

How can I change the "Licensee" name that I see on the screen and printout?
The "Licensee" name is contained within your Product Control Code (PCC). If there is a spelling error or you
wish to modify the name then all we need to do is supply you with a new Product Control Code. All the other
information will be unchanged and you will not need to re-activate your software.

Activation
We use an “Internet Activation” method to allow the software to run in a “registered” mode. Without activation it
runs as an “Evaluation” version. If the user cannot internet activate we offer a manual activation method.
How does the ENERCALC software connect to the activation server?
The activation server is contacted on port 80 using the URL www.mykron.com. This is not a URL that will
display a web page. We use this simple connection to get through firewall and anti-virus software. The data
sent is an encrypted text string. If the software cannot contact the server it’s usually because your firewall or
anti virus software does not allow our EC6.EXE program access to the internet. In rare cases a user will have a
proxy server that cannot be automatically located.

How can I change the activation to a different computer?
Use “Internet Deactivate” on the current active computer.
Go to the other computer and use “Internet Activate”.
The activation system can also remotely deactivate the first computer if you forget. Very convenient!
What if I don’t deactivate from my computer prior to moving the activation to another computer ?
Our activation system contacts our activation server for permission. If the activation server knows that another
computer is currently it will give you the option of deactivating it. The next time you start the SEL on the other
computer it will deactivate itself.
When I try “Internet Activate” it says the server can’t be reached.
This is caused by the SEL or NLM being unable to contact our activation server. Check your firewall, anti-virus
software, proxy server settings and of course whether you have an Internet connection.
When I try to activate I get a message that the software is already activated.
This indicates that you activated the software on another computer and did not deactivate before attempting
activation on your new computer. You must “Internet Deactivate” your other computer. Alternately if you have a
computer failure contact technical support.
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Do I need an Internet connection while using the software?
You do not need to be connected to the Internet to use the software. The only time an Internet connection is
required is when you wish to:
l
When "Activating" or “Deactivating” the software on a computer.
l
When you need to check and download/install updates.
l
When you wish to send a Technical Support Email.
“Product Control Code” will not work ?
Product Control Codes always work unless they are corrupted. Many times users ask this question when the
truth is they are denied the ability to “Internet Activate”. See other documentation here on activation.
It is possible that your email program corrupts the PCC. In that case simply paste the PCC into the “Notepad”
program supplied with Windows. It will strip out any bad characters. Then look for any numbers enclosed in
angle brackets ( <20>). Delete both brackets and number between them. If it still does not work sent it to us
and we will remove the bad characters.
My hard drive crashed and I couldn’t deactivate the software
My computer was stolen and I couldn’t deactivate the software
(Other similar reasons)
Contact technical support, including your KW number, and they will assist you.

Installing Updates
The current versions of the software are posted at the top of the “For Our Users” section of www.enercalc.com.
If you have an active Maintenance & Support Plan you can install the latest version of the software. To update
your existing SEL use the menu selection Help -> Check For Updates to have the latest update installed. If your
MSP is expired you can only update to the most recent version that was released while your MSP was active.
Use the same menu selection and the updating program will determine what version that is and install it.
You can also use the “Latest Structural Engineering Library Program Update” link on the “For Our Users” page
at www.enercalc.com.
What is “Web Update”?
The ability of the SEL and NLM to check a simple version file on our server to determine the latest version
release of the software. Typically it checks automatically in the background whenever the software is started.
If you have turned off the update check (in the settings menu) or something is blocking our software from
connecting to our web server then no update check can be performed.
If a new version is detected you will be offered the choice to install it. If you have an expired Maintenance &
Support Plan then the latest release cannot be installed and web update will offer the most recent version you
are allowed to have.
My Maintenance & Support Plan is currently active but I cannot get the current version update installed.
The most common reason is that you have not pasted your most recent Product Control Code into the
software. When you renew MSP you receive a new Product Control Code which contains the new MSP
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expiration date. Simply locate the delivery email (or ask for a resend) and follow the instructions contained
therein.
I have a network license and not all computers are running the same version.
You simply need to update the software on each computer. Use the menu item Help -> Check for Updates in
the program. Or use this link to use our generic update program :
http://www.enercalc.com/Users/ECSEL_WEBUPDATE
I have a network license and get the message “No Product Control Code Found”
Updating the SEL when using a network license is still a little tricky for our updating system. We've made
changes that should improve things with the current build of the software. Please contact ENERCALC technical
support with your “KW” number to receive a simplified direct update link your computers.

Network License Specific
The network license uses a Network License Manager (NLM) to grant permission for the SEL programs
installed on various computers to run. Only one NLM is used per network license and only the NLM is
“Activated”.
For troubleshooting help with a network license look at this document :
http://www.enercalc.com/pdf/EC_V6_Install_Network.pdf

How can I move the Network License Manager to a different computer?
This involves two steps:
First you need to Internet Deactivate your current NLM installation. To do that (1) Stop the NLM running as a
service, (2) Start the NLM from the [Start] menu, (3) Select the “Licensing” tab, (4) Click on the [Click here for
Activation and Deactivation] button and (5) Click on the [Internet Deactivate] button.
Next you need to install the NLM on the new computer. You can use our typical installation program for this
task. Here is the link : http://www.enercalc.com/downloads/ECSEL6_SETUP.htm
Third paste in your Product Control Code and “Internet Activate” it.
Lastly you need to tell the installed Structural Engineering Library program where the NLM is now activated.
Because the system uses either “broadcasting” or “direct IP” methods please refer to the network installation
guide here : http://www.enercalc.com/pdf/EC_V6_Install_Network.pdf

Maintenance & Support Plan
An active Maintenance &Support Plan allows you to receive the latest version updates and technical
assistance. MSP can be renewed at this web address : www.enercalc.com/renew
What help can I get if I do not renew ?
Your software continues to operate with no changes! When the plan expires you will no longer receive updates,
upgrades or technical support. However we will still assist with installation of the last software version you were
eligible for when your plan was active (not expired) for 12 months following expiration. After that providing help
is at our discretion.
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What happens when I renew?
When you renew you will receive a new Product Control Code (PCC) and instructions on entering it into your
software. The new PCC contains all information about your license in a single encrypted string. You simply
paste the new PCC into all installations of the SEL (or just in the NLM for network licenses).

Do I need to reinstall after renewing MSP ?
No. After you paste in your new PCC the program will be able to obtain latest version updates.

General Usage Questions
My software is “activated” but the printouts say “Evaluation Version?
Printouts are saved to the project file when you “save” them. This is what allows you to use the project
managers “Project Print” system.....all the printouts are already prepared and ready to print. If you use the
software as an “Evaluation Version” the printout is saved with the evaluation version notation in the title block. If
you later activate the software on that computer those words “Evaluation Version” will still be on the printouts.
So you need to either (1) load and re-save the calculation with the software running “activated” or (2)
regenerate all the calcs with the activated version using the main menu item File -> Regenerate All Printouts”.
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